
INTR
O

N

TO
MANAGEM

EN
T

SCIENCE

Introduction

CHAPTER 1 INTR

OD
U
CT

IO
N

TO
MANAGEM

EN
T

SCIENCE

Tho
m

so
n 

Lea
rn

in
g™

CONTENTS

1.1 PROBLEM SOLVING AND
DECISION MAKING

1.2 QUANTITATIVE ANALYSIS
AND DECISION MAKING

1.3 QUANTITATIVE ANALYSIS
Model Development
Data Preparation
Model Solution
Report Generation
A Note Regarding Implementation

1.4 MODELS OF COST, REVENUE,
AND PROFIT
Cost and Volume Models
Revenue and Volume Models
Profit and Volume Models
Breakeven Analysis

1.5 MANAGEMENT SCIENCE
TECHNIQUES
Methods Used Most Frequently



Tho
m

so
n 

Lea
rn

in
g™

2 INTRODUCTION TO MANAGEMENT SCIENCE

MANAGEMENT SCIENCE IN ACTION

REVENUE MANAGEMENT AT AMERICAN AIRLINES*

One of the great success stories in management sci-
ence involves the work done by the operations re-
search (OR) group at American Airlines. In 1982,
Thomas M. Cook joined a group of 12 operations re-
search analysts at American Airlines. Under Cook’s
guidance, the OR group quickly grew to a staff of 
75 professionals who developed models and con-
ducted studies to support senior management deci-
sion making. Today the OR group is called Sabre 
and employs 10,000 professionals worldwide.

One of the most significant applications devel-
oped by the OR group came about because of the
deregulation of the airline industry in the late

1970s. As a result of deregulation, a number of low-
cost airlines were able to move into the market by
selling seats at a fraction of the price charged by es-
tablished carriers such as American Airlines. Fac-
ing the question of how to compete, the OR group
suggested offering different fare classes (discount
and full fare) and in the process created a new area
of management science referred to as yield or reve-
nue management.

The OR group used forecasting and optimiza-
tion techniques to determine how many seats to sell
at a discount and how many seats to hold for full
fare. Although the initial implementation was rela-

Management science, an approach to decision making based on the scientific method,
makes extensive use of quantitative analysis. A variety of names exists for the body of
knowledge involving quantitative approaches to decision making; in addition to manage-
ment science, two other widely known and accepted names are operations research and de-
cision science. Today, many use the terms management science, operations research, and
decision science interchangeably.

The scientific management revolution of the early 1900s, initiated by Frederic W. Tay-
lor, provided the foundation for the use of quantitative methods in management. But mod-
ern management science research is generally considered to have originated during the
World War II period, when teams were formed to deal with strategic and tactical problems
faced by the military. These teams, which often consisted of people with diverse specialties
(e.g., mathematicians, engineers, and behavioral scientists), were joined together to solve a
common problem through the utilization of the scientific method. After the war, many of
these team members continued their research in the field of management science.

Two developments that occurred during the post–World War II period led to the growth
and use of management science in nonmilitary applications. First, continued research re-
sulted in numerous methodological developments. Probably the most significant develop-
ment was the discovery by George Dantzig, in 1947, of the simplex method for solving
linear programming problems. At the same time these methodological developments were
taking place, digital computers prompted a virtual explosion in computing power. Com-
puters enabled practitioners to use the methodological advances to solve a large variety of
problems. The computer technology explosion continues, and personal computers can now
be used to solve problems larger than those solved on mainframe computers in the 1990s.

As stated in the Preface, the purpose of the text is to provide students with a sound con-
ceptual understanding of the role that management science plays in the decision-making
process. We also said that the text is applications oriented. To reinforce the applications na-
ture of the text and to provide a better understanding of the variety of applications in which
management science has been used successfully, Management Science in Action articles
are presented throughout the text. Each Management Science in Action article summarizes
an application of management science in practice. The first Management Science in Action
in this chapter, Revenue Management at American Airlines, describes one of the most sig-
nificant applications of management science in the airline industry.
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Chapter 1 Introduction 3

tively crude, the group continued to improve the
forecasting and optimization models that drive the
system and to obtain better data. Tom Cook counts
at least four basic generations of revenue manage-
ment during his tenure. Each produced in excess of
$100 million in incremental profitability over its
predecessor. This revenue management system at
American Airlines generates nearly $1 billion an-
nually in incremental revenue.

Today, virtually every airline uses some sort of
revenue management system. The cruise, hotel,
and car rental industries also now apply revenue
management methods, a further tribute to the pio-
neering efforts of the OR group at American Air-
lines and its leader, Thomas M. Cook.

*Based on Peter Horner, “The Sabre Story,” OR/MS
Today (June 2000).

1.1 PROBLEM SOLVING AND DECISION MAKING

Problem solving can be defined as the process of identifying a difference between the ac-
tual and the desired state of affairs and then taking action to resolve the difference. For prob-
lems important enough to justify the time and effort of careful analysis, the problem-solving
process involves the following seven steps:

1. Identify and define the problem.
2. Determine the set of alternative solutions.
3. Determine the criterion or criteria that will be used to evaluate the alternatives.
4. Evaluate the alternatives.
5. Choose an alternative.
6. Implement the selected alternative.
7. Evaluate the results to determine whether a satisfactory solution has been obtained.

Decision making is the term generally associated with the first five steps of the problem-
solving process. Thus, the first step of decision making is to identify and define the prob-
lem. Decision making ends with the choosing of an alternative, which is the act of making
the decision.

Let us consider the following example of the decision-making process. For the moment
assume that you are currently unemployed and that you would like a position that will lead
to a satisfying career. Suppose that your job search has resulted in offers from companies
in Rochester, New York; Dallas, Texas; Greensboro, North Carolina; and Pittsburgh, Penn-
sylvania. Thus, the alternatives for your decision problem can be stated as follows:

1. Accept the position in Rochester.
2. Accept the position in Dallas.
3. Accept the position in Greensboro.
4. Accept the position in Pittsburgh.

The next step of the problem-solving process involves determining the criteria that will be
used to evaluate the four alternatives. Obviously, the starting salary is a factor of some impor-
tance. If salary were the only criterion of importance to you, the alternative selected as “best”
would be the one with the highest starting salary. Problems in which the objective is to find the
best solution with respect to one criterion are referred to as single-criterion decision problems.

Suppose that you also conclude that the potential for advancement and the location of
the job are two other criteria of major importance. Thus, the three criteria in your decision
problem are starting salary, potential for advancement, and location. Problems that involve
more than one criterion are referred to as multicriteria decision problems.

The next step of the decision-making process is to evaluate each of the alternatives with
respect to each criterion. For example, evaluating each alternative relative to the starting



Starting Potential for Job
Alternative Salary Advancement Location
1. Rochester $38,500 Average Average
2. Dallas $36,000 Excellent Good
3. Greensboro $36,000 Good Excellent
4. Pittsburgh $37,000 Average Good

TABLE 1.1 DATA FOR THE JOB EVALUATION DECISION-MAKING PROBLEM
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4 INTRODUCTION TO MANAGEMENT SCIENCE

salary criterion is done simply by recording the starting salary for each job alternative. Evalu-
ating each alternative with respect to the potential for advancement and the location of the
job is more difficult to do, however, because these evaluations are based primarily on sub-
jective factors that are often difficult to quantify. Suppose for now that you decide to mea-
sure potential for advancement and job location by rating each of these criteria as poor, fair,
average, good, or excellent. The data that you compile are shown in Table 1.1.

You are now ready to make a choice from the available alternatives. What makes this
choice phase so difficult is that the criteria are probably not all equally important, and no
one alternative is “best” with regard to all criteria. Although we will present a method for
dealing with situations like this one later in the text, for now let us suppose that after a care-
ful evaluation of the data in Table 1.1, you decide to select alternative 3; alternative 3 is thus
referred to as the decision.

At this point in time, the decision-making process is complete. In summary, we see that
this process involves five steps:

1. Define the problem.
2. Identify the alternatives.
3. Determine the criteria.
4. Evaluate the alternatives.
5. Choose an alternative.

Note that missing from this list are the last two steps in the problem-solving process: im-
plementing the selected alternative and evaluating the results to determine whether a satis-
factory solution has been obtained. This omission is not meant to diminish the importance
of each of these activities, but to emphasize the more limited scope of the term decision
making as compared to the term problem solving. Figure 1.1 summarizes the relationship
between these two concepts.

1.2 QUANTITATIVE ANALYSIS AND DECISION MAKING

Consider the flowchart presented in Figure 1.2. Note that it combines the first three steps
of the decision-making process under the heading of “Structuring the Problem” and the lat-
ter two steps under the heading “Analyzing the Problem.” Let us now consider in greater
detail how to carry out the set of activities that make up the decision-making process.

Figure 1.3 shows that the analysis phase of the decision-making process may take two
basic forms: qualitative and quantitative. Qualitative analysis is based primarily on the
manager’s judgment and experience; it includes the manager’s intuitive “feel” for the prob-
lem and is more an art than a science. If the manager has had experience with similar prob-
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Chapter 1 Introduction 5

lems, or if the problem is relatively simple, heavy emphasis may be placed upon a qualita-
tive analysis. However, if the manager has had little experience with similar problems, or
if the problem is sufficiently complex, then a quantitative analysis of the problem can be an
especially important consideration in the manager’s final decision.

When using the quantitative approach, an analyst will concentrate on the quantita-
tive facts or data associated with the problem and develop mathematical expressions that
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6 INTRODUCTION TO MANAGEMENT SCIENCE

describe the objectives, constraints, and other relationships that exist in the problem. Then,
by using one or more quantitative methods, the analyst will make a recommendation based
on the quantitative aspects of the problem.

Although skills in the qualitative approach are inherent in the manager and usually
increase with experience, the skills of the quantitative approach can be learned only by
studying the assumptions and methods of management science. A manager can increase
decision-making effectiveness by learning more about quantitative methodology and by
better understanding its contribution to the decision-making process. A manager who is
knowledgeable in quantitative decision-making procedures is in a much better position to
compare and evaluate the qualitative and quantitative sources of recommendations and ul-
timately to combine the two sources in order to make the best possible decision.

The box in Figure 1.3 entitled “Quantitative Analysis” encompasses most of the sub-
ject matter of this text. We will consider a managerial problem, introduce the appropriate
quantitative methodology, and then develop the recommended decision.

In closing this section, let us briefly state some of the reasons why a quantitative ap-
proach might be used in the decision-making process:

1. The problem is complex, and the manager cannot develop a good solution without
the aid of quantitative analysis.

2. The problem is especially important (e.g., a great deal of money is involved), and
the manager desires a thorough analysis before attempting to make a decision.

3. The problem is new, and the manager has no previous experience from which to draw.
4. The problem is repetitive, and the manager saves time and effort by relying on quan-

titative procedures to make routine decision recommendations.

1.3 QUANTITATIVE ANALYSIS

From Figure 1.3 we see that quantitative analysis begins once the problem has been struc-
tured. It usually takes imagination, teamwork, and considerable effort to transform a rather
general problem description into a well-defined problem that can be approached via quan-
titative analysis. The more the analyst is involved in the process of structuring the problem,

Quantitative methods are
especially helpful with
large, complex problems.
For example, in the
coordination of the
thousands of tasks
associated with landing
Apollo 11 safely on the
moon, quantitative
techniques helped to 
ensure that more than
300,000 pieces of work
performed by more than
400,000 people were
integrated smoothly.

Try Problem 4 to test your
understanding of why
quantitative approaches
might be needed in a
particular problem.



(1.1)P � 10x
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Chapter 1 Introduction 7

the more likely the ensuing quantitative analysis will make an important contribution to the
decision-making process.

To successfully apply quantitative analysis to decision making, the management scien-
tist must work closely with the manager or user of the results. When both the management
scientist and the manager agree that the problem has been adequately structured, work can
begin on developing a model to represent the problem mathematically. Solution procedures
can then be employed to find the best solution for the model. This best solution for the
model then becomes a recommendation to the decision maker. The process of developing
and solving models is the essence of the quantitative analysis process.

Model Development
Models are representations of real objects or situations and can be presented in various
forms. For example, a scale model of an airplane is a representation of a real airplane. Simi-
larly, a child’s toy truck is a model of a real truck. The model airplane and toy truck are ex-
amples of models that are physical replicas of real objects. In modeling terminology,
physical replicas are referred to as iconic models.

A second classification includes models that are physical in form but do not have the
same physical appearance as the object being modeled. Such models are referred to as ana-
log models. The speedometer of an automobile is an analog model; the position of the nee-
dle on the dial represents the speed of the automobile. A thermometer is another analog
model representing temperature.

A third classification of models—the type we will primarily be studying—includes rep-
resentations of a problem by a system of symbols and mathematical relationships or ex-
pressions. Such models are referred to as mathematical models and are a critical part of
any quantitative approach to decision making. For example, the total profit from the sale of
a product can be determined by multiplying the profit per unit by the quantity sold. If we
let x represent the number of units sold and P the total profit, then, with a profit of $10 per
unit, the following mathematical model defines the total profit earned by selling x units:

The purpose, or value, of any model is that it enables us to make inferences about the
real situation by studying and analyzing the model. For example, an airplane designer might
test an iconic model of a new airplane in a wind tunnel to learn about the potential flying
characteristics of the full-size airplane. Similarly, a mathematical model may be used to
make inferences about how much profit will be earned if a specified quantity of a particu-
lar product is sold. According to the mathematical model of equation (1.1), we would ex-
pect selling three units of the product (x � 3) would provide a profit of P � 10(3) � $30.

In general, experimenting with models requires less time and is less expensive than ex-
perimenting with the real object or situation. A model airplane is certainly quicker and less
expensive to build and study than the full-size airplane. Similarly, the mathematical model
in equation (1.1) allows a quick identification of profit expectations without actually re-
quiring the manager to produce and sell x units. Models also have the advantage of reduc-
ing the risk associated with experimenting with the real situation. In particular, bad designs
or bad decisions that cause the model airplane to crash or a mathematical model to project
a $10,000 loss can be avoided in the real situation.

The value of model-based conclusions and decisions is dependent on how well the
model represents the real situation. The more closely the model airplane represents the real



(1.2)5x � 40
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8 INTRODUCTION TO MANAGEMENT SCIENCE

airplane, the more accurate the conclusions and predictions will be. Similarly, the more
closely the mathematical model represents the company’s true profit-volume relationship,
the more accurate the profit projections will be.

Because this text deals with quantitative analysis based on mathematical models, let us
look more closely at the mathematical modeling process. When initially considering a man-
agerial problem, we usually find that the problem definition phase leads to a specific ob-
jective, such as maximization of profit or minimization of cost, and possibly a set of
restrictions or constraints, such as production capacities. The success of the mathematical
model and quantitative approach will depend heavily on how accurately the objective and
constraints can be expressed in terms of mathematical equations or relationships.

A mathematical expression that describes the problem’s objective is referred to as the
objective function. For example, the profit equation P � 10x would be an objective func-
tion for a firm attempting to maximize profit. A production capacity constraint would be
necessary if, for instance, 5 hours are required to produce each unit and only 40 hours of
production time are available per week. Let x indicate the number of units produced each
week. The production time constraint is given by

The value of 5x is the total time required to produce x units; the symbol � indicates that the
production time required must be less than or equal to the 40 hours available.

The decision problem or question is the following: How many units of the product
should be scheduled each week to maximize profit? A complete mathematical model for
this simple production problem is

The x � 0 constraint requires the production quantity x to be greater than or equal to zero,
which simply recognizes the fact that it is not possible to manufacture a negative number
of units. The optimal solution to this model can be easily calculated and is given by x � 8,
with an associated profit of $80. This model is an example of a linear programming model.
In subsequent chapters we will discuss more complicated mathematical models and learn
how to solve them in situations where the answers are not nearly so obvious.

In the preceding mathematical model, the profit per unit ($10), the production time per
unit (5 hours), and the production capacity (40 hours) are environmental factors that are not
under the control of the manager or decision maker. Such environmental factors, which can
affect both the objective function and the constraints, are referred to as uncontrollable in-
puts to the model. Inputs that are controlled or determined by the decision maker are re-
ferred to as controllable inputs to the model. In the example given, the production quantity
x is the controllable input to the model. Controllable inputs are the decision alternatives
specified by the manager and thus are also referred to as the decision variables of the model.

Once all controllable and uncontrollable inputs are specified, the objective function and
constraints can be evaluated and the output of the model determined. In this sense, the out-
put of the model is simply the projection of what would happen if those particular envi-

5x � 40

 x � 0 � constraints

Maximize

subject to (s.t.)

P � 10x  objective function

 

Herbert A. Simon, a Nobel
Prize winner in economics
and an expert in decision
making, said that a
mathematical model does
not have to be exact; it just
has to be close enough to
provide better results than
can be obtained by common
sense.
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ronmental factors and decisions occurred in the real situation. A flowchart of how control-
lable and uncontrollable inputs are transformed by the mathematical model into output is
shown in Figure 1.4. A similar flowchart showing the specific details of the production
model is shown in Figure 1.5.

As stated earlier, the uncontrollable inputs are those the decision maker cannot influ-
ence. The specific controllable and uncontrollable inputs of a model depend on the particu-
lar problem or decision-making situation. In the production problem, the production time
available (40) is an uncontrollable input. However, if it were possible to hire more em-
ployees or use overtime, the number of hours of production time would become a control-
lable input and therefore a decision variable in the model.

Uncontrollable inputs can either be known exactly or be uncertain and subject to vari-
ation. If all uncontrollable inputs to a model are known and cannot vary, the model is re-
ferred to as a deterministic model. Corporate income tax rates are not under the influence
of the manager and thus constitute an uncontrollable input in many decision models. Be-
cause these rates are known and fixed (at least in the short run), a mathematical model with
corporate income tax rates as the only uncontrollable input would be a deterministic model.
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The distinguishing feature of a deterministic model is that the uncontrollable input values
are known in advance.

If any of the uncontrollable inputs are uncertain and subject to variation, the model is
referred to as a stochastic or probabilistic model. An uncontrollable input to many pro-
duction planning models is demand for the product. A mathematical model that treats fu-
ture demand—which may be any of a range of values—with uncertainty would be called
a stochastic model. In the production model, the number of hours of production time re-
quired per unit, the total hours available, and the unit profit were all uncontrollable inputs.
Because the uncontrollable inputs were all known to take on fixed values, the model was
deterministic. If, however, the number of hours of production time per unit could vary from
3 to 6 hours depending on the quality of the raw material, the model would be stochastic.
The distinguishing feature of a stochastic model is that the value of the output cannot be de-
termined even if the value of the controllable input is known because the specific values of
the uncontrollable inputs are unknown. In this respect, stochastic models are often more dif-
ficult to analyze.

Data Preparation
Another step in the quantitative analysis of a problem is the preparation of the data required
by the model. Data in this sense refer to the values of the uncontrollable inputs to the model.
All uncontrollable inputs or data must be specified before we can analyze the model and
recommend a decision or solution for the problem.

In the production model, the values of the uncontrollable inputs or data were $10 per
unit for profit, 5 hours per unit for production time, and 40 hours for production capacity.
In the development of the model, these data values were known and incorporated into the
model as it was being developed. If the model is relatively small and the uncontrollable
input values or data required are few, the quantitative analyst will probably combine model
development and data preparation into one step. In these situations the data values are in-
serted as the equations of the mathematical model are developed.

However, in many mathematical modeling situations, the data or uncontrollable input
values are not readily available. In these situations the management scientist may know that
the model will need profit per unit, production time, and production capacity data, but the
values will not be known until the accounting, production, and engineering departments can
be consulted. Rather than attempting to collect the required data as the model is being de-
veloped, the analyst will usually adopt a general notation for the model development step
and then a separate data preparation step will be performed to obtain the uncontrollable
input values required by the model.

Using the general notation

the model development step of the production problem would result in the following gen-
eral model:

Max

s.t.

 

 

  

cx

 

ax

x

 

 

� b

� 0

c �

a �

b �

profit per unit

production time in hours per unit

production capacity in hours
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A separate data preparation step to identify the values for c, a, and b would then be neces-
sary to complete the model.

Many inexperienced quantitative analysts assume that once the problem has been de-
fined and a general model developed, the problem is essentially solved. These individuals
tend to believe that data preparation is a trivial step in the process and can be easily han-
dled by clerical staff. Actually, this assumption could not be further from the truth, espe-
cially with large-scale models that have numerous data input values. For example, a
moderately sized linear programming model with 50 decision variables and 25 constraints
could have more than 1300 data elements that must be identified in the data preparation
step. The time required to prepare these data and the possibility of data collection errors will
make the data preparation step a critical part of the quantitative analysis process. Often, a
fairly large database is needed to support a mathematical model, and information systems
specialists may become involved in the data preparation step.

Model Solution
Once the model development and data preparation steps are completed, we can proceed to
the model solution step. In this step, the analyst will attempt to identify the values of the de-
cision variables that provide the “best” output for the model. The specific decision-variable
value or values providing the “best” output will be referred to as the optimal solution for
the model. For the production problem, the model solution step involves finding the value
of the production quantity decision variable x that maximizes profit while not causing a vio-
lation of the production capacity constraint.

One procedure that might be used in the model solution step involves a trial-and-error
approach in which the model is used to test and evaluate various decision alternatives. In
the production model, this procedure would mean testing and evaluating the model under
various production quantities or values of x. Referring to Figure 1.5, note that we could
input trial values for x and check the corresponding output for projected profit and satis-
faction of the production capacity constraint. If a particular decision alternative does not
satisfy one or more of the model constraints, the decision alternative is rejected as being in-
feasible, regardless of the objective function value. If all constraints are satisfied, the deci-
sion alternative is feasible and a candidate for the “best” solution or recommended decision.
Through this trial-and-error process of evaluating selected decision alternatives, a decision
maker can identify a good—and possibly the best—feasible solution to the problem. This
solution would then be the recommended decision for the problem.

Table 1.2 shows the results of a trial-and-error approach to solving the production
model of Figure 1.5. The recommended decision is a production quantity of 8 because the
feasible solution with the highest projected profit occurs at x � 8.

Although the trial-and-error solution process is often acceptable and can provide valu-
able information for the manager, it has the drawbacks of not necessarily providing the best
solution and of being inefficient in terms of requiring numerous calculations if many deci-
sion alternatives are tried. Thus, quantitative analysts have developed special solution pro-
cedures for many models that are much more efficient than the trial-and-error approach.
Throughout this text, you will be introduced to solution procedures that are applicable to
the specific mathematical models that will be formulated. Some relatively small models or
problems can be solved by hand computations, but most practical applications require the
use of a computer.

Model development and model solution steps are not completely separable. An analyst
will want both to develop an accurate model or representation of the actual problem situa-
tion and to be able to find a solution to the model. If we approach the model development



Decision Alternative Total Feasible
(Production Quantity) Projected Hours of Solution?

x Profit Production (Hours Used ≤ 40)
0 0 0 Yes
2 20 10 Yes
4 40 20 Yes
6 60 30 Yes
8 80 40 Yes

10 100 50 No
12 120 60 No

TABLE 1.2 TRIAL-AND-ERROR SOLUTION FOR THE PRODUCTION MODEL
OF FIGURE 1.5
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12 INTRODUCTION TO MANAGEMENT SCIENCE

step by attempting to find the most accurate and realistic mathematical model, we may find
the model so large and complex that it is impossible to obtain a solution. In this case, a sim-
pler and perhaps more easily understood model with a readily available solution procedure
is preferred even if the recommended solution is only a rough approximation of the best de-
cision. As you learn more about quantitative solution procedures, you will have a better idea
of the types of mathematical models that can be developed and solved.

After a model solution is obtained, both the management scientist and the manager will
be interested in determining how good the solution really is. Even though the analyst has
undoubtedly taken many precautions to develop a realistic model, often the goodness or ac-
curacy of the model cannot be assessed until model solutions are generated. Model testing
and validation are frequently conducted with relatively small “test” problems that have
known or at least expected solutions. If the model generates the expected solutions, and if
other output information appears correct, the go-ahead may be given to use the model on
the full-scale problem. However, if the model test and validation identify potential prob-
lems or inaccuracies inherent in the model, corrective action, such as model modification
and/or collection of more accurate input data, may be taken. Whatever the corrective ac-
tion, the model solution will not be used in practice until the model has satisfactorily passed
testing and validation.

Report Generation
An important part of the quantitative analysis process is the preparation of managerial re-
ports based on the model’s solution. Referring to Figure 1.3, we see that the solution based
on the quantitative analysis of a problem is one of the inputs the manager considers before
making a final decision. Thus, the results of the model must appear in a managerial report
that can be easily understood by the decision maker. The report includes the recommended
decision and other pertinent information about the results that may be helpful to the deci-
sion maker.

A Note Regarding Implementation
As discussed in Section 1.2, the manager is responsible for integrating the quantitative so-
lution with qualitative considerations in order to make the best possible decision. After
completing the decision-making process, the manager must oversee the implementation and

Try Problem 8 to test your
understanding of the
concept of a mathematical
model and what is referred
to as the optimal solution to
the model.
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follow-up evaluation of the decision. During the implementation and follow-up, the man-
ager should continue to monitor the contribution of the model. At times, this process may
lead to requests for model expansion or refinement that will cause the management scien-
tist to return to an earlier step of the quantitative analysis process.

Successful implementation of results is of critical importance to the management scien-
tist as well as the manager. If the results of the quantitative analysis process are not correctly
implemented, the entire effort may be of no value. It doesn’t take too many unsuccessful im-
plementations before the management scientist is out of work. Because implementation of-
ten requires people to do things differently, it often meets with resistance. People want to
know, “What’s wrong with the way we’ve been doing it?” and so on. One of the most ef-
fective ways to ensure successful implementation is to include users throughout the model-
ing process. A user who feels a part of identifying the problem and developing the solution
is much more likely to enthusiastically implement the results. The success rate for imple-
menting the results of a management science project is much greater for those projects char-
acterized by extensive user involvement. The Management Science in Action, Quantitative
Analysis at Merrill Lynch, discusses some of the reasons for the success Merrill Lynch has
realized from using quantitative analysis.

MANAGEMENT SCIENCE IN ACTION

QUANTITATIVE ANALYSIS AT MERRILL LYNCH*

Merrill Lynch, a brokerage and financial services
firm with more than 56,000 employees in 45 coun-
tries, serves its client base through two business
units. The Merrill Lynch Corporate and Institutional
Client Group serves more than 7,000 corporations,
institutions, and governments. The Merrill Lynch
Private Client Group (MLPC) serves approximately
4 million households, as well as 225,000 small to
mid-sized businesses and regional financial institu-
tions, through more than 14,000 financial consul-
tants in 600-plus branch offices. The management
science group, established in 1986, has been part of
MLPC since 1991. The mission of this group is to
provide high-end quantitative analysis to support
strategic management decisions and to enhance the
financial consultant–client relationship.

The management science group has successfully
implemented models and developed systems for
asset allocation, financial planning, marketing infor-
mation technology, database marketing, and port-
folio performance measurement. Although technical
expertise and objectivity are clearly important fac-
tors in any analytical group, the management science
group attributes much of its success to communica-
tions skills, teamwork, and consulting skills.

Each project begins with face-to-face meetings
with the client. A proposal is then prepared to out-
line the background of the problem, the objectives

of the project, the approach, the required resources,
the time schedule, and the implementation issues.
At this stage, analysts focus on developing solu-
tions that provide significant value and are easily
implemented.

As the work progresses, frequent meetings
keep the clients up-to-date. Because people with
different skills, perspectives, and motivations must
work together for a common goal, teamwork is es-
sential. The group’s members take classes in team
approaches, facilitation, and conflict resolution.
They possess a broad range of multifunctional and
multidisciplinary capabilities and are motivated to
provide solutions that focus on the goals of the firm.
This approach to problem solving and the imple-
mentation of quantitative analysis has been a hall-
mark of the management science group. The impact
and success of the group translates into hard dollars
and repeat business. The group recently received
the annual Edelman award given by the Institute for
Operations Research and the Management Sciences
for effective use of management science for organi-
zational success.

*Based on Russ Labe, Raj Nigam, and Steve Spence,
“Management Science at Merrill Lynch Private Client
Group,” Interfaces 29, no. 2 (March/April 1999): 1–14.
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NOTES AND COMMENTS

1. Developments in computer technology have in-
creased the availability of management science
techniques to decision makers. Many software
packages are now available for personal com-
puters. Versions of The Management Scientist,
Microsoft Excel, and LINDO are widely used in
management science courses.

2. The Management Scientist is a software pack-
age developed by the authors of this text. Ver-
sion 6.0 is now available for Windows 95 through

XPoperating systems. This software can be used
to solve problems in the text as well as small-
scale problems encountered in practice. Appen-
dix 1.1 provides an overview of the features and
use of The Management Scientist.

3. Various chapter appendixes provide step-by-
step instructions for using The Management
Scientist, Excel, and LINDO to solve problems
in the text.

1.4 MODELS OF COST, REVENUE, AND PROFIT

Some of the most basic quantitative models arising in business and economic applications
are those involving the relationship between a volume variable—such as production vol-
ume or sales volume—and cost, revenue, and profit. Through the use of these models, a
manager can determine the projected cost, revenue, and/or profit associated with an estab-
lished production quantity or a forecasted sales volume. Financial planning, production
planning, sales quotas, and other areas of decision making can benefit from such cost, reve-
nue, and profit models.

Cost and Volume Models
The cost of manufacturing or producing a product is a function of the volume produced.
This cost can usually be defined as a sum of two costs: fixed cost and variable cost. Fixed
cost is the portion of the total cost that does not depend on the production volume; this cost
remains the same no matter how much is produced. Variable cost, on the other hand, is the
portion of the total cost that is dependent on and varies with the production volume. To il-
lustrate how cost and volume models can be developed, we will consider a manufacturing
problem faced by Nowlin Plastics.

Nowlin Plastics produces a variety of compact disc (CD) storage cases. Nowlin’s best-
selling product is the CD-50, a slim, plastic CD holder with a specially designed lining that
protects the optical surface of the disc. Several products are produced on the same manu-
facturing line, and a setup cost is incurred each time a changeover is made for a new prod-
uct. Suppose that the setup cost for the CD-50 is $3000. This setup cost is a fixed cost that
is incurred regardless of the number of units eventually produced. In addition, suppose that
variable labor and material costs are $2 for each unit produced. The cost-volume model for
producing x units of the CD-50 can be written as

(1.3)C(x) � 3000 � 2x

where

x �

C(x) �

production volume in units

total cost of producing x units



(1.4)R(x) � 5x
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Once a production volume is established, the model in equation (1.3) can be used to
compute the total production cost. For example, the decision to produce x � 1200 units
would result in a total cost of C(1200) � 3000 � 2(1200) � $5400.

Marginal cost is defined as the rate of change of the total cost with respect to produc-
tion volume. That is, it is the cost increase associated with a one-unit increase in the pro-
duction volume. In the cost model of equation (1.3), we see that the total cost C(x) will
increase by $2 for each unit increase in the production volume. Thus, the marginal cost is
$2. With more complex total cost models, marginal cost may depend on the production vol-
ume. In such cases, we could have marginal cost increasing or decreasing with the produc-
tion volume x.

Revenue and Volume Models
Management of Nowlin Plastics will also want information on the projected revenue asso-
ciated with selling a specified number of units. Thus, a model of the relationship between
revenue and volume is also needed. Suppose that each CD-50 storage unit sells for $5. The
model for total revenue can be written as

where

Marginal revenue is defined as the rate of change of total revenue with respect to
sales volume. That is, it is the increase in total revenue resulting from a one-unit increase
in sales volume. In the model of equation (1.4), we see that the marginal revenue is $5. In
this case, marginal revenue is constant and does not vary with the sales volume. With more
complex models, we may find that marginal revenue increases or decreases as the sales
volume x increases.

Profit and Volume Models
One of the most important criteria for management decision making is profit. Managers
need to be able to know the profit implications of their decisions. If we assume that we will
only produce what can be sold, the production volume and sales volume will be equal. We
can combine equations (1.3) and (1.4) to develop a profit-volume model that will determine
the total profit associated with a specified production-sales volume. Total profit, denoted
P(x), is total revenue minus total cost; therefore, the following model provides the total
profit associated with producing and selling x units:

x �

R(x) �

sales volume in units

total revenue associated with selling x units

Thus, the profit-volume model can be derived from the revenue-volume and cost-volume
models.

(1.5)
P(x)

 

� R(x) � C(x)

� 5x � (3000 � 2x) � �3000 � 3x
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Breakeven Analysis
Using equation (1.5), we can now determine the total profit associated with any production
volume x. For example, suppose that a demand forecast indicates that 500 units of the prod-
uct can be sold. The decision to produce and sell the 500 units results in a projected profit of

In other words, a loss of $1500 is predicted. If sales are expected to be 500 units, the man-
ager may decide against producing the product. However, a demand forecast of 1800 units
would show a projected profit of

This profit may be enough to justify proceeding with the production and sale of the product.
We see that a volume of 500 units will yield a loss, whereas a volume of 1800 provides

a profit. The volume that results in total revenue equaling total cost (providing $0 profit) is
called the breakeven point. If the breakeven point is known, a manager can quickly infer
that a volume above the breakeven point will result in a profit, while a volume below the
breakeven point will result in a loss. Thus, the breakeven point for a product provides valu-
able information for a manager who must make a yes/no decision concerning production of
the product.

Let us now return to the Nowlin Plastics example and show how the total profit model
in equation (1.5) can be used to compute the breakeven point. The breakeven point can be
found by setting the total profit expression equal to zero and solving for the production vol-
ume. Using equation (1.5), we have

With this information, we know that production and sales of the product must be greater
than 1000 units before a profit can be expected. The graphs of the total cost model, the total
revenue model, and the location of the breakeven point are shown in Figure 1.6. In Appen-
dix 1.2 we also show how Excel can be used to perform a breakeven analysis for the Nowlin
Plastics production example.

1.5 MANAGEMENT SCIENCE TECHNIQUES

In this section we present a brief overview of the management science techniques covered
in this text. Over the years, practitioners have found numerous applications for the follow-
ing techniques:

Linear Programming. Linear programming is a problem-solving approach developed for
situations involving maximizing or minimizing a linear function subject to linear constraints
that limit the degree to which the objective can be pursued. The production model developed
in Section 1.3 (see Figure 1.5) is an example of a simple linear programming model.

Integer Linear Programming. Integer linear programming is an approach used for prob-
lems that can be set up as linear programs with the additional requirement that some or all
of the decision recommendations be integer values.

P(x) � �3000 � 3x �

3x �

x �

0

3000

1000

P(1800) � �3000 � 3(1800) � 2400

P(500) � �3000 � 3(500) � �1500

Try Problem 12 to test your
ability to determine the
breakeven point for a
quantitative model.
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Network Models. A network is a graphical description of a problem consisting of circles
called nodes that are interconnected by lines called arcs. Specialized solution procedures
exist for these types of problems, enabling us to quickly solve problems in such areas as
transportation system design, information system design, and project scheduling.

Project Scheduling: PERT/CPM. In many situations, managers are responsible for plan-
ning, scheduling, and controlling projects that consist of numerous separate jobs or tasks
performed by a variety of departments, individuals, and so forth. The PERT (Program Evalu-
ation and Review Technique) and CPM (Critical Path Method) techniques help managers
carry out their project scheduling responsibilities.

Inventory Models. Inventory models are used by managers faced with the dual problems
of maintaining sufficient inventories to meet demand for goods and, at the same time, in-
curring the lowest possible inventory holding costs.

Waiting Line or Queueing Models. Waiting-line or queueing models have been devel-
oped to help managers understand and make better decisions concerning the operation of
systems involving waiting lines.

Simulation. Simulation is a technique used to model the operation of a system. This
technique employs a computer program to model the operation and perform simulation
computations.

Decision Analysis. Decision analysis can be used to determine optimal strategies in situ-
ations involving several decision alternatives and an uncertain or risk-filled pattern of events.

Goal Programming. Goal programming is a technique for solving multicriteria decision
problems, usually within the framework of linear programming.

Analytic Hierarchy Process. This multicriteria decision-making technique permits the
inclusion of subjective factors in arriving at a recommended decision.

Forecasting. Forecasting methods are techniques that can be used to predict future as-
pects of a business operation.

Markov Process Models. Markov process models are useful in studying the evolution 
of certain systems over repeated trials. For example, Markov processes have been used to
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describe the probability that a machine, functioning in one period, will function or break
down in another period.

Dynamic Programming. Dynamic programming is an approach that allows us to break
up a large problem in such a fashion that once all the smaller problems have been solved,
we are left with an optimal solution to the large problem.

Methods Used Most Frequently
Our experience as both practitioners and educators has been that the most frequently 
used management science techniques are linear programming, integer programming, net-
work models (including transportation and transshipment models), and simulation. De-
pending upon the industry, the other methods in the preceding list are used more or less
frequently.

Helping to bridge the gap between the manager and the management scientist is a major
focus of the text. We believe that the barriers to the use of management science can best 
be removed by increasing the manager’s understanding of how management science can be
applied. The text will help you develop an understanding of which management science
techniques are most useful, how they are used, and, most importantly, how they can assist
managers in making better decisions.

The Management Science in Action, Taco Bell’s SMART Labor Management System,
shows how Taco Bell was able to use management science to ensure that the maximum time
customers wait in line is between three and five minutes. The SMART system consists of
three models: a forecasting model, a simulation model, and an integer programming model.
This system has provided Taco Bell with a major competitive advantage and is typical of
the widespread role of management science in service industries. Throughout the text we
will continue to illustrate the applications of management science with Management Sci-
ence in Action articles.

MANAGEMENT SCIENCE IN ACTION

TACO BELL’S SMART LABOR MANAGEMENT SYSTEM*

Taco Bell turned to management science in order to
develop methods for better handling customer de-
mand while still keeping labor costs down. The
company created the SMART (Scheduling Manage-
ment and Restaurant Tool) Labor Management Sys-
tem (LMS) in order to determine a method of
scheduling employees that will ensure that the maxi-
mum time customers wait in line is between three
and five minutes. The SMART LMS consists of
three integrated models: a forecasting model, a simu-
lation model, and an integer programming model.

The forecasting model determines how many
dollars worth of business each store will generate
each day. Unlike a manufacturing plant, which
makes forecasts in terms of years, months, or
weeks, Taco Bell needs to develop predictions of
customer arrivals based on 15-minute intervals.

Then, using the predictions of how much business
a store will generate the following day, a simulation
model determines how many employees will be
needed and how they should be positioned through-
out the facility. To determine the labor table for the
next day, the simulation model must take into ac-
count the differences in Taco Bell facilities, the
build-to-order food preparation approach used by
Taco Bell, and the randomness associated with
customer demand. Using the labor table generated
by the simulation model, the integer programming
model determines how many people are needed on
the schedule for a particular day and what their
shifts should be so that payroll costs are minimized.
The integer programming model also takes into
account all of the customer-service responsibili-
ties and provides Taco Bell managers with the
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SUMMARY

This text is about how management science may be used to help managers make better de-
cisions. The focus of this text is on the decision-making process and on the role of man-
agement science in that process. We discussed the problem orientation of this process and
in an overview showed how mathematical models can be used in this type of analysis.

The difference between the model and the situation or managerial problem it represents
is an important point. Mathematical models are abstractions of real-world situations and, as
such, cannot capture all the aspects of the real situation. However, if a model can capture
the major relevant aspects of the problem and can then provide a solution recommendation,
it can be a valuable aid to decision making.

One of the characteristics of management science that will become increasingly appar-
ent as we proceed through the text is the search for a best solution to the problem. In carry-
ing out the quantitative analysis, we shall be attempting to develop procedures for finding
the “best” or optimal solution.

GLOSSARY

Problem solving The process of identifying a difference between the actual and the de-
sired state of affairs and then taking action to resolve the difference.

Decision making The process of defining the problem, identifying the alternatives, de-
termining the criteria, evaluating the alternatives, and choosing an alternative.

Single-criterion decision problem A problem in which the objective is to find the “best”
solution with respect to just one criterion.

Multicriteria decision problem A problem that involves more than one criterion; the ob-
jective is to find the “best” solution, taking into account all the criteria.

ability to schedule other tasks such as cleaning and
maintenance.

The system is used in all company-owned stores,
and by 1996 had been adopted by 70 percent of fran-
chisees. From 1993–1996, the new system resulted in
labor costs savings of $40.34 million. Employee

feedback is positive, and other fast-food companies
have indicated that the new system has provided Taco
Bell with a major competitive advantage.

*Based on Nancy Bistritz, “Taco Bell Finds Recipe
for Success,” OR/MS Today (October 1997): 20–21.

NOTES AND COMMENTS

1. Operations research analyst is listed by the Bureau
of Labor Statistics as one of the fastest growing oc-
cupations for careers requiring a bachelor’s de-
gree. The predicted growth is from 57,000 jobs in
1990 to 100,000 jobs in 2005, an increase of 73%.

2. The Institute for Operations Research and the
Management Sciences (INFORMS) and the Deci-

sion Sciences Institute (DSI) are two professional
societies that publish journals and newsletters
dealing with current research and applications of
operations research and management science
techniques.
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Decision The alternative selected.

Model A representation of a real object or situation.

Iconic model A physical replica, or representation, of a real object.

Analog model Although physical in form, an analog model does not have a physical ap-
pearance similar to the real object or situation it represents.

Mathematical model Mathematical symbols and expressions used to represent a real
situation.

Constraints Restrictions or limitations imposed on a problem.

Objective function A mathematical expression that describes the problem’s objective.

Uncontrollable inputs The environmental factors or inputs that cannot be controlled by
the decision maker.

Controllable inputs The inputs that are controlled or determined by the decision maker.

Decision variable Another term for controllable input.

Deterministic model A model in which all uncontrollable inputs are known and can-
not vary.

Stochastic (probabilistic) model A model in which at least one uncontrollable input 
is uncertain and subject to variation; stochastic models are also referred to as probabilistic
models.

Optimal solution The specific decision-variable value or values that provide the “best”
output for the model.

Infeasible solution A decision alternative or solution that does not satisfy one or more
constraints.

Feasible solution A decision alternative or solution that satisfies all constraints.

Fixed cost The portion of the total cost that does not depend on the volume; this cost re-
mains the same no matter how much is produced.

Variable cost The portion of the total cost that is dependent on and varies with the volume.

Marginal cost The rate of change of the total cost with respect to volume.

Marginal revenue The rate of change of total revenue with respect to volume.

Breakeven point The volume at which total revenue equals total cost.

PROBLEMS

1. Define the terms management science and operations research.

2. List and discuss the steps of the decision-making process.

3. Discuss the different roles played by the qualitative and quantitative approaches to man-
agerial decision making. Why is it important for a manager or decision maker to have a
good understanding of both of these approaches to decision making?

4. A firm just completed a new plant that will produce more than 500 different products, us-
ing more than 50 different production lines and machines. The production scheduling de-
cisions are critical in that sales will be lost if customer demands are not met on time. If no
individual in the firm has experience with this production operation, and if new produc-



Tho
m

so
n 

Lea
rn

in
g™

Chapter 1 Introduction 21

tion schedules must be generated each week, why should the firm consider a quantitative
approach to the production scheduling problem?

5. What are the advantages of analyzing and experimenting with a model as opposed to a real
object or situation?

6. Suppose that a manager has a choice between the following two mathematical models of
a given situation: (a) a relatively simple model that is a reasonable approximation of the
real situation, and (b) a thorough and complex model that is the most accurate mathemati-
cal representation of the real situation possible. Why might the model described in part (a)
be preferred by the manager?

7. Suppose you are going on a weekend trip to a city that is d miles away. Develop a model
that determines your round-trip gasoline costs. What assumptions or approximations are
necessary to treat this model as a deterministic model? Are these assumptions or approxi-
mations acceptable to you?

8. Recall the production model from Section 1.3:

Suppose the firm in this example considers a second product that has a unit profit of $5
and requires 2 hours of production time for each unit produced. Use y as the number of
units of product 2 produced.
a. Show the mathematical model when both products are considered simultaneously.
b. Identify the controllable and uncontrollable inputs for this model.
c. Draw the flowchart of the input-output process for this model (see Figure 1.5).
d. What are the optimal solution values of x and y?
e. Is the model developed in part (a) a deterministic or a stochastic model? Explain.

9. Suppose we modify the production model in Problem 8 to obtain the following mathe-
matical model:

where a is the number of hours of production time required for each unit produced. With
a � 5, the optimal solution is x � 8. If we have a stochastic model with a � 3, a � 4,
a � 5, or a � 6 as the possible values for the number of hours required per unit, what is
the optimal value for x? What problems does this stochastic model cause?

10. A retail store in Des Moines, Iowa, receives shipments of a particular product from Kansas
City and Minneapolis. Let

x �

y �

number of units of the product received from Kansas City

number of units of the product received from Minneapolis

Max

s.t.
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a. Write an expression for the total number of units of the product received by the retail
store in Des Moines.

b. Shipments from Kansas City cost $0.20 per unit, and shipments from Minneapolis cost
$0.25 per unit. Develop an objective function representing the total cost of shipments
to Des Moines.

c. Assuming the monthly demand at the retail store is 5000 units, develop a constraint
that requires 5000 units to be shipped to Des Moines.

d. No more than 4000 units can be shipped from Kansas City, and no more than 3000 units
can be shipped from Minneapolis in a month. Develop constraints to model this situation.

e. Of course, negative amounts cannot be shipped. Combine the objective function and
constraints developed to state a mathematical model for satisfying the demand at the
Des Moines retail store at minimum cost.

11. For most products, higher prices result in a decreased demand, whereas lower prices result
in an increased demand. Let

Assume that a firm accepts the following price-demand relationship as being realistic:

where p must be between $20 and $70.
a. How many units can the firm sell at the $20 per-unit price? At the $70 per-unit price?
b. Show the mathematical model for the total revenue (TR), which is the annual demand

multiplied by the unit price.
c. Based on other considerations, the firm’s management will only consider price alter-

natives of $30, $40, and $50. Use your model from part (b) to determine the price al-
ternative that will maximize the total revenue.

d. What are the expected annual demand and the total revenue corresponding to your rec-
ommended price?

12. The O’Neill Shoe Manufacturing Company will produce a special-style shoe if the order
size is large enough to provide a reasonable profit. For each special-style order, the com-
pany incurs a fixed cost of $1000 for the production setup. The variable cost is $30 per
pair, and each pair sells for $40.
a. Let x indicate the number of pairs of shoes produced. Develop a mathematical model

for the total cost of producing x pairs of shoes.
b. Let P indicate the total profit. Develop a mathematical model for the total profit real-

ized from an order for x pairs of shoes.
c. How large must the shoe order be before O’Neill will break even?

13. Micromedia offers computer training seminars on a variety of topics. In the seminars each
student works at a personal computer, practicing the particular activity that the instructor
is presenting. Micromedia is currently planning a two-day seminar on the use of Microsoft
Excel in statistical analysis. The projected fee for the seminar is $300 per student. The cost
for the conference room, instructor compensation, lab assistants, and promotion is $4,800.
Micromedia rents computers for its seminars at a cost of $30 per computer per day.
a. Develop a model for the total cost to put on the seminar. Let x represent the number

of students who enroll in the seminar.
b. Develop a model for the total profit if x students enroll in the seminar.
c. Micromedia has forecasted an enrollment of 30 students for the seminar. How much

profit will be earned if their forecast is accurate?
d. Compute the breakeven point.

d � 800 � 10p

d �

p �

annual demand for a product in units

price per unit



Maximum
Price/ Estimated Annual Possible

Stock Share Return/Share Investment

Oil Alaska $50 $6 $50,000
Southwest Petroleum $30 $4 $45,000
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14. Eastman Publishing Company is considering publishing a paperback textbook on spread-
sheet applications for business. The fixed cost of manuscript preparation, textbook design,
and production setup is estimated to be $80,000. Variable production and material costs are
estimated to be $3 per book. Demand over the life of the book is estimated to be 4000 copies.
The publisher plans to sell the text to college and university bookstores for $20 each.
a. What is the breakeven point?
b. What profit or loss can be anticipated with a demand of 4000 copies?
c. With a demand of 4000 copies, what is the minimum price per copy that the publisher

must charge to break even?
d. If the publisher believes that the price per copy could be increased to $25.95 and not

affect the anticipated demand of 4000 copies, what action would you recommend?
What profit or loss can be anticipated?

15. Preliminary plans are under way for the construction of a new stadium for a major league
baseball team. City officials have questioned the number and profitability of the luxury
corporate boxes planned for the upper deck of the stadium. Corporations and selected in-
dividuals may buy the boxes for $100,000 each. The fixed construction cost for the upper-
deck area is estimated to be $1,500,000, with a variable cost of $50,000 for each box
constructed.
a. What is the breakeven point for the number of luxury boxes in the new stadium?
b. Preliminary drawings for the stadium show that space is available for the construction

of up to 50 luxury boxes. Promoters indicate that buyers are available and that all 
50 could be sold if constructed. What is your recommendation concerning the con-
struction of luxury boxes? What profit is anticipated?

16. Financial Analysts, Inc., is an investment firm that manages stock portfolios for a number
of clients. A new client is requesting that the firm handle an $80,000 portfolio. As an ini-
tial investment strategy, the client would like to restrict the portfolio to a mix of the fol-
lowing two stocks:

Let

a. Develop the objective function, assuming that the client desires to maximize the total
annual return.

b. Show the mathematical expression for each of the following three constraints:
(1) Total investment funds available are $80,000.
(2) Maximum Oil Alaska investment is $50,000.
(3) Maximum Southwest Petroleum investment is $45,000.

Note: Adding the x � 0 and y � 0 constraints provides a linear programming model 
for the investment problem. A solution procedure for this model will be discussed in
Chapter 2.

x �

y �

number of shares of Oil Alaska

number of shares of Southwest Petroleum
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17. Models of inventory systems frequently consider the relationships among a beginning in-
ventory, a production quantity, a demand or sales, and an ending inventory. For a given
production period j, let

a. Write the mathematical relationship or model that describes how these four variables
are related.

b. What constraint should be added if production capacity for period j is given by Cj?
c. What constraint should be added if inventory requirements for period j mandate an

ending inventory of at least Ij?

Case Problem SCHEDULING A GOLF LEAGUE

Chris Lane, the head professional at Royal Oak Country Club, must develop a schedule of
matches for the couples’ golf league that begins its season at 4:00 p.m. tomorrow. Eighteen
couples signed up for the league, and each couple must play every other couple over the
course of the 17-week season. Chris thought it would be fairly easy to develop a schedule,
but after working on it for a couple of hours, he has been unable to come up with a sched-
ule. Because Chris must have a schedule ready by tomorrow afternoon, he asked you to help
him. A possible complication is that one of the couples told Chris that they may have to can-
cel for the season. They told Chris they will let him know by 1:00 p.m. tomorrow whether
they will be able to play this season.

Managerial Report
Prepare a report for Chris Lane. Your report should include, at a minimum, the following
items:

1. A schedule that will enable each of the 18 couples to play every other couple over
the 17-week season.

2. A contingency schedule that can be used if the couple that contacted Chris decides
to cancel for the season.

Appendix 1.1 THE MANAGEMENT SCIENTIST SOFTWARE

Developments in computer technology play a major role in making management science
techniques available to decision makers. A software package called The Management Sci-
entist accompanies this text. Version 6.0 is now available for Windows 95 through Win-
dows XP operating systems.1 This software can be used to solve problems in the text as
well as small-scale problems encountered in practice. Using The Management Scientist

sj�1 �

xj �

dj �

sj �

ending inventory from the previous period (beginning inventory for period j
 
)

production quantity in period j

demand in period j

ending inventory for period j

1Version 6.0 has been designed to run optimally on computers with screen resolutions of 1024 � 768 or higher. Computers
with lower screen resolutions can still run Version 6.0. Scroll bars appear when necessary for working with large problems.



FIGURE 1.7 MODULE SELECTION SCREEN FOR THE MANAGEMENT SCIENTIST
VERSION 6.0
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will give you an understanding and appreciation of the role of the computer in applying
management science to decision problems.

The Management Scientist contains 12 modules, or programs, that will enable you to
solve problems in the following areas:

Chapters 2–6 Linear programming
Chapter 7 Transportation and assignment
Chapter 8 Integer linear programming
Chapter 9 Shortest route and minimal spanning tree
Chapter 10 PERT/CPM
Chapter 11 Inventory models
Chapter 12 Waiting line models
Chapter 14 Decision analysis
Chapter 16 Forecasting
Chapter 17 Markov processes

Use of The Management Scientist with the text is optional. Occasionally, we insert a
figure in the text that shows the output The Management Scientist provides for a problem.
However, familiarity with the use of the software is not necessary to understand the figure
and the text material. The remainder of this appendix provides an overview of the features
and the use of the software.

Selecting a Module
After starting The Management Scientist, you will encounter the module selection screen
as shown in Figure 1.7. The choices provide access to the 12 modules. Simply click the de-
sired module and select OK to load the requested module into the computer’s memory.
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The File Menu
After a module is loaded, you will need to click the File menu to begin working with a prob-
lem. The File menu provides the following options.

New Select this option to begin a new problem. Dialog boxes and input templates will
guide you through the data input process.

Open Select this option to retrieve a problem that has been previously saved. When the
problem is selected it will be displayed on the screen for you to verify as the problem you
want to solve.

Save Once a new problem has been entered, you may want to save it for future use or
modification. The Save option will guide you through the naming and saving process. If
you create a folder named Problems, the Open and Save options will take you automatically
to the Problems folder.

Change Modules This option returns control to the screen in Figure 1.7 and another
module may be selected.

Exit This option will exit The Management Scientist.

The Edit Menu
After a new problem has been solved, you may want to make one or more modifications
to the problem before resolving. The Edit menu provides the option to display the prob-
lem and then make revisions in the problem before solving or saving. In the linear and in-
teger programming modules, the Edit menu also includes options to change the problem
size by adding or deleting variables and adding or deleting constraints. Similar options to
change the problem size are provided in the Edit menu of the transportation and assign-
ment modules.

The Solution Menu
The Solution menu provides three options.

Solve This option solves the current problem and displays the solution on the screen.

Print Once the solution is on the screen, the Print option sends the solution to a printer.

Save As Text File Once the solution is on the screen, the Save As Text File option enables
the solution to be saved as a text file. The text file can be accessed later by a word processor
so that the solution output may be displayed as part of a solution report.

Advice About Data Input
Any time a new problem is selected, the appropriate module will provide dialog boxes and
forms for describing the features of the problem and for entering data. When using The
Management Scientist, you may find the following data input suggestions helpful.

1. Do not enter commas (,) with your input data. For example, the value 104,000
should be entered with the six digits: 104000.

2. Do not enter the dollar sign ($) for profit or cost data. For example, a cost of $20.00
should be entered as 20.



FIGURE 1.8 FORMULA WORKSHEET FOR THE NOWLIN PLASTICS 
PRODUCTION EXAMPLE
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3. Do not enter the percent sign (%) if percentage is requested. For example, 25%
should be entered as 25, not 25% or .25.

4. Occasionally, a model may be formulated with fractional values such as ¹⁄₄, ²⁄₃, ⁵⁄₆,
and so on. The data input for The Management Scientist must be in decimal form.
The fraction ¹⁄₄ can be entered as .25. However, fractions such as ²⁄₃ and ⁵⁄₆ have re-
peating decimal forms. In these cases, we recommend the convention of rounding
to five places such as .66667 and .83333.

5. Finally, we recommend that in general you attempt to scale extremely large input
data so that smaller numbers may be input and operated on by the computer. For ex-
ample, costs such as $2,500,000 may be scaled to 2.5 with the understanding that
the data used in the problem reflect millions of dollars.

Appendix 1.2 USING EXCEL FOR BREAKEVEN ANALYSIS

In Section 1.4 we introduced the Nowlin Plastics production example to illustrate how
quantitative models can be used to help a manager determine the projected cost, revenue,
and/or profit associated with an established production quantity or a forecasted sales vol-
ume. In this appendix we introduce spreadsheet applications by showing how to use Micro-
soft Excel to perform a quantitative analysis of the Nowlin Plastics example.

Refer to the worksheet shown in Figure 1.8. We begin by entering the problem data into
the top portion of the worksheet. The value of 3000 in cell B3 is the setup cost, the value of
2 in cell B5 is the variable labor and material costs per unit, and the value of 5 in cell B7 is



FIGURE 1.9 SOLUTION USING A PRODUCTION VOLUME OF 800 UNITS FOR THE
NOWLIN PLASTICS PRODUCTION EXAMPLE
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the selling price per unit. In general, whenever we perform a quantitative analysis using
Excel, we will enter the problem data in the top portion of the worksheet and reserve the
bottom portion for model development. The label “Models” in cell A10 helps to provide a
visual reminder of this convention.

Cell B12 in the models portion of the worksheet contains the proposed production vol-
ume in units. Because the values for total cost, total revenue, and total profit depend upon
the value of this decision variable, we have placed a border around cell B12 and screened
the cell for emphasis. Based upon the value in cell B12, the cell formulas in cells B14, B16,
and B18 are used to compute values for total cost, total revenue, and total profit (loss), re-
spectively. First, recall that the value of total cost is the sum of the fixed cost (cell B3)
and the total variable cost. The total variable cost—the product of the variable cost per unit
(cell B5) and the production volume (cell B12)—is given by B5*B12. Thus, to compute
the value of total cost we entered the formula �B3�B5*B12 in cell B14. Next, total
revenue is the product of the selling price per unit (cell B7) and the number of units pro-
duced (cell B12), which is entered in cell B16 as the formula �B7*B12. Finally, the
total profit (or loss) is the difference between the total revenue (cell B16) and the total cost
(cell B14). Thus, in cell B18 we have entered the formula �B16�B14. The worksheet
shown in Figure 1.8 shows the formulas used to make these computations; we refer to it as
a formula worksheet.

To examine the effect of selecting a particular value for the production volume, we en-
tered a value of 800 in cell B12. The worksheet shown in Figure 1.9 shows the values ob-
tained by the formulas; a production volume of 800 units results in a total cost of $4600, a
total revenue of $4000, and a loss of $600. To examine the effect of other production vol-



FIGURE 1.10 GOAL SEEK DIALOG BOX FOR THE NOWLIN PLASTICS 
PRODUCTION EXAMPLE
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umes, we only need to enter a different value into cell B12. To examine the effect of dif-
ferent costs and selling prices, we simply enter the appropriate values in the data portion of
the worksheet; the results will be displayed in the model section of the worksheet.

In Section 1.4 we illustrated breakeven analysis. Let us now see how Excel’s Goal Seek
tool can be used to compute the breakeven point for the Nowlin Plastics production example.

Determining the Breakeven Point Using Excel’s Goal Seek Tool
The breakeven point is the production volume that results in total revenue equal to total cost
and hence a profit of $0. One way to determine the breakeven point is to use a trial-and-error
approach. For example, in Figure 1.9 we saw that a trial production volume of 800 units re-
sulted in a loss of $600. Because this trial solution resulted in a loss, a production volume
of 800 units cannot be the breakeven point. We could continue to experiment with other
production volumes by simply entering different values into cell B12 and observing the re-
sulting profit or loss in cell B18. A better approach is to use Excel’s Goal Seek tool to de-
termine the breakeven point.

Excel’s Goal Seek tool allows the user to determine the value for an input cell that will
cause the value of a related output cell to equal some specified value (called the goal ). In
the case of breakeven analysis, the “goal” is to set Total Profit to zero by “seeking” an ap-
propriate value for Production Volume. Goal Seek will allow us to find the value of pro-
duction volume that will set Nowlin Plastics’ total profit to zero. The following steps
describe how to use Goal Seek to find the breakeven point for Nowlin Plastics:

Step 1. Select the Tools menu
Step 2. Choose the Goal Seek option
Step 3. When the Goal Seek dialog box appears:

Enter B18 in the Set cell box
Enter 0 in the To value box
Enter B12 in the By changing cell box
Click OK

The completed Goal Seek dialog box is shown in Figure 1.10, and the worksheet ob-
tained after selecting OK is shown in Figure 1.11. The Total Profit in cell B18 is zero, and
the Production Volume in cell B12 has been set to the breakeven point of 1000.



FIGURE 1.11 BREAKEVEN POINT FOUND USING EXCEL’S GOAL SEEK TOOL
FOR THE NOWLIN PLASTICS PRODUCTION EXAMPLE
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